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1. 版本管理 

版本更新说明表 

版本号 内容 时间 

V1.0 增加数字解调和脉冲选件测量说明 2025-3-27 

V1.1 
1.增加相位噪声测试功能说明  

2.修改触发功能介绍（以最新上位机软件为准） 

2025-4-3 

V1.2 
DET 模式增加脉冲信号测试 

2025-4-8 

V1.3 
1.增加概率密度图章节 

2.删除 SWP 模式脉冲检测、数字解调硬狗使用说明 

2025-4-11 

V1.4 
1.修改脉冲检测和数字解调选件安装许可的方式 

2.修改查看 GNSS 信息的方式 

3.修改 IP3 测量方法 

2025-6-27 

V1.5 
1.增加 SEM 章节 

2.增加谐波分析章节 

3.增加显示偏移和主题、参数设置 

4.增加幅度修正和 Graph 功能 

5.增加解析外部 GNSS 信息章节 

2025-7-15 
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2. 快速入门指南 

本章为 PX 系列仪器的快速入门指南，主要内容包括安全指导，仪器开机和关机，上位机软件运行说明和

仪器外部接口说明。 

2.1 安全指导 

2.1.1 安全细则 

1.当您收到仪器，开启前请检查以下项目： 

▪ 仪器外观是否完好； 

▪ 电源线、适配器是否损坏； 

▪ 风扇出风口是否保持通畅； 

▪ 仪器是否干燥无潮，无冷凝； 

▪ 环境温度是否符合对应产品手册指定范围； 

▪ 使用前若发现仪器任何损坏，请联系官方售后服务。 

2.仪器使用过程中，请遵循以下准则： 

▪ 确保风扇正常工作且仪器工作温度符合对应产品手册指定范围； 

▪ 正确连接仪器所有相关外部接口且射频输入接口端信号电平符合产品手册指定范围； 

▪ 确保仪器电池电量高于 5%； 

▪ 不得打开仪器外壳，谨防电击； 

▪ 若出现故障或无法正常运行，请及时联系官方售后服务。 

3.仪器完成使用后，请遵循以下准则： 

▪ 仪器正常关机后，请将其存放在符合产品手册中规定的温度和湿度范围的环境中。 



 

PX 系列用户指南 3 

2.1.2 更换电源适配器 

若您因某些情况无法使用原厂电源适配器，请务必根据对应产品手册，选择规格合适的电源适配器，以确

保仪器正常使用。 

2.1.3 更换电池 

PX 系列仪器支持更换电池，如需更换，请联系官方售后服务渠道进行处理，切勿自行拆卸设备。 

2.2 外部接口说明 

为便于用户操作，仪器的所有接口均集成于顶层面板，各接口的详细说明请查阅表 1。 

 

图 1 上面板接口说明 

表 1 仪器上面板接口说明 

序号 接口名称 描述 

1 电源开关 打开/关闭仪器 

2 充电端口 
仪器充电端口，USB PD3.0 20 V 3.25 A，请按照仪器要求

的工作电压连接电源 

3 Micro HDMI 扩展显示 

4 USB3 USB 接口：其中 USB3 为 USB 3.0 接口，USB1 和 USB2 为

USB 2.0 接口。通过该接口连接外部扩展存储器和 USB 键

盘、鼠标；或连接免驱动带网口的 Hub，通过网线连接至

PC，PC 对仪器进行远程控制 

5 USB2 

6 USB1 

7 音频输出 
3.5 mm 耳机接口，可在菜单栏中通过“系统”→“参数设

置”→“音量”调节音量 

8 多功能 MUXIO 详细描述参见表 2 
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9 充电指示灯 绿色闪烁为正在充电，绿色常亮为充满 

10 模拟中频输出 MMCX (F)，最大输出功率-25 dBm，输出阻抗 50 Ω 

11 触发输出 3.3V CMOS 

12 触发输入 3.3V CMOS，输入阻抗为高阻 

13 参考时钟输入 
MMCX (F)，幅度≥1.5 Vpp，输入阻抗 330 Ω。参考时钟输

入：正弦、方波、削峰正弦均可 

14 GNSS 天线 MMCX (F)，幅度≥1.5 Vpp，输入阻抗 330 Ω 

15 射频信号输入 
PXE-200：N (F)，输入阻抗 50 Ω 

PXN-400：2.4mm (M)，输入阻抗 50 Ω 

表 2 端口 8 多功能 MUXIO PIN 接口说明（图示方向从左至右） 

引脚 名称 方向 电平标准 含义 

1 GPIO0 / / 预留 

2 TRG IO2 / / 预留 

3 GPIO1 / / 预留 

4 GND / / 接地 

5 GPIO2 / / 预留 

6 3V3/5VIN O / 
电源输出，PXN-400 和 PXE 系列 

5 V 输出 

7 GPIO3 / / 预留 

8 GND / / 接地 

9 USART_TX_FP / / 预留 

10 SYNC_RXRFLO I 3.3V 射频本振同步 

11 SYNC_ADCCLK I 3.3V ADC 时钟同步 

12 SYNC_RXIFLO I 3.3V 中频本振同步 

13 GND / / 接地 

14 REFCLK_OUT_FP O / 
参考时钟输出，可输出 10 MHz 标

准时钟信号 
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2.3 仪器首次使用 

仪器经过长途运输，电池电量可能会在 5%以下，建议首次使用前，先连接随寄电源适配器，再开机使用。 

2.3.1 打开和关闭仪器 

通过仪器上方的电源按钮（端口 1）打开/关闭仪器。仪器开机后，蓝色电源指示灯亮起；关机后，电源

指示灯熄灭。 

2.3.2 充电指示灯 

当仪器连接电源适配器后，充电状态灯（端口 9）闪烁绿色灯光，表示正在充电。当电池充满电后，充电

指示灯将变为绿色常亮。 

2.3.3 运行上位机软件 

按下电源按钮，仪器开机后将进入桌面环境，并自动启动上位机软件。 

  



 

PX 系列用户指南 6 

3. 软件概述 

本章主要对软件的界面布局、工作模式和常用功能进行说明。 

3.1 工作模式介绍 

PX 系列仪器提供多种工作模式，主要包括标准频谱分析、IQ 流、检波分析、实时频谱分析、谐波分析、

相位噪声测量和基础数字解调，每种工作模式具备的测量功能将在以下章节进行详细说明。 

3.1.1 标准频谱分析模式（SWP） 

SWP 模式下，仪器根据配置进行跳频以实现频率扫描，该模式适用于面向频率迹线的测量与分析应用。

SWP 模式提供的测量分析功能包括： 

◼ 频谱全景扫描 ◼ IP3/IM3 测试 

◼ 频谱局部放大显示 ◼ 信道功率（Channel Power）测试 

◼ 瀑布图 ◼ 占用带宽（OBW）测试 

◼ 频谱数据记录与回放 ◼ 邻道功率比（ACPR）测试 

◼ 信号追踪 ◼ 峰值表 

3.1.2 IQ流模式（IQS） 

IQS 模式下，仪器根据指定的触发信号对分析带宽内的时域数据进行采集并返回给用户。IQS 模式适用

于时域信号记录、基础解调分析等应用。IQS 模式提供的功能包括： 

◼ IQ 时域波形图 ◼ IQ 数据的频谱分析 

◼ 瀑布图 ◼ AM/FM 解调 

◼ 功率-时间波形图 ◼ 音频分析 

◼ 多通道数字下变频（DDC） ◼ IQ 数据记录与回放 

◼ 脉冲信号检测（选件） 
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3.1.3 检波分析模式（DET） 

DET 模式下，仪器对分析带宽内的时域信号进行连续的检波分析。DET 模式适用于观察一定带宽内，时

间和功率的关系。例如脉冲参数测量。DET 模式提供的功能包括： 

◼ 功率-时间波形图及缩放图 ◼ DET 数据记录与回放 

◼ 脉冲信号检测（选件） 
 

3.1.4 实时频谱分析模式（RTA） 

RTA 模式下，仪器对分析带宽内的时域信号进行实时频谱分析，并将频谱结果返回给用户。RTA 模式适

用于关注瞬时及突发信号的应用，例如干扰排查、复杂电磁环境下特征信号的识别等。RTA 模式提供的

功能包括： 

◼ 实时频谱概率密度图和瀑布图 ◼ 实时频谱数据数据记录与回放 

3.1.5 谐波分析模式 

在谐波分析模式下，仪器基于基波对信号进行谐波分析，并显示各次谐波的频率、幅度及其与基波的差

值。该模式适用于分析信号中的谐波失真，帮助识别和评估信号的非线性特征。谐波分析模式提供的功能

包括： 

◼ 谐波谱图 ◼ 谐波测量表 

3.1.6 相位噪声测量模式（PNM） 

在相位噪声测量模式下，仪器通过自动化测量技术，提供高精度的相位噪声谱图和详细的数据表。这些测

量结果帮助用户深入分析信号的相位稳定性、噪声分布以及不同频率偏移下的噪声密度。相位噪声测量

模式提供的功能包括： 

◼ 单边带相位噪声谱图 ◼ 相位噪声测量表 
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3.1.7数字解调模式（选件） 

数字解调模式下，仪器对多种调制信号进行解调，并从多个维度分析信号的调制质量。此解调功能适用于

多个应用场景，尤其是在需要对已知调制信号进行深入分析、质量评估及数据提取的环境中。数字解调模

式提供的功能包括： 

◼ 星座图和眼图 ◼ 比特表、解调参数说明 

◼ 调制信号频谱分析 ◼ ASK/FSK/PSK/GMSK/QAM 解调 

3.2 界面布局 

上位机软件界面由以下部分组成： 

◼ 菜单栏（Menu） ◼ 图表设置区（Graph Set Area） 

◼ 图表显示区（Graph Display Area） ◼ 主设置区（Main Setting Area） 

◼ 仪器状态栏（Instrument State） ◼ 参数快捷设置区（Parameter Quick Set） 

 

图 2 上位机界面布局 
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3.2.1 菜单栏 

◼ 保存与载入配置文件 ◼ 设置启动状态 

◼ 工作模式切换 ◼ 测量模式选择 

◼ 单次与连续预览 ◼ 记录与回放 

◼ 快捷截图 ◼ GNSS、仪器信息查看 

3.2.2 图表设置区 

◼ 图表设置 ◼ 迹线操作 

◼ 游标操作 ◼ 显示测量结果 

3.2.3 主设置区 

◼ 测量与分析设置 ◼ 触发设置 

◼ 数据记录与回放 ◼ 系统设置 

3.2.4 仪器状态栏 

◼ 仪器型号 ◼ 软件与硬件版本 

◼ 仪器实时温度 ◼ 总线数据吞吐量 

◼ GNSS 天线连接状态 ◼ 仪器电量 
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4. 通用操作 

4.1 常用功能介绍 

4.1.1 保存和打开仪器配置 

1. 保存当前配置 

(1) 点击菜单栏中的“文件”，选择“保存配置”； 

(2) 在“保存配置文件”弹窗中，设置保存路径和文件名，点击“确认”保存配置文件。 

2. 打开预存配置 

(1) 点击菜单栏中的“文件”，选择“打开配置”； 

(2) 在“请选择文件”弹窗中选择配置文件，点击“确认”打开预存配置。 

4.1.2 设置启动状态 

PX 系列仪器支持用户自定义启动状态，相关启动状态说明详见表 3。 

表 3 上位机软件启动状态 

序号 启动状态名称  

1 默认 仪器默认配置 

2 用户预设 选择用户预存的配置文件作为启动的初始配置 

3 最近一次 使用上一次退出软件时的参数配置作为启动的初始配置 

若您想进行启动状态设置，请按照以下步骤进行。 

1. 点击菜单栏中的“文件”，选择“启动状态”设置软件启动状态; 

2. “默认”和“最近一次”直接勾选即可，下一次启动软件时将以该选择作为启动的初始状态; 

3. 选择“用户预设”，在出现的“请选择文件”弹窗中选择用户预存的配置文件，然后点击“确认”。下

次启动时，软件将以用户指定的配置打开。 
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4.1.3 切换工作模式 

点击菜单栏中的“模式”，可以将上位机软件的工作模式切换至标准频谱分析模式（SWP）、IQ 流模式

（IQS）、检波分析模式（DET）、实时频谱分析模式（RTA）、相位噪声测量模式（PNM）、谐波分析

模式和数字解调模式。 

 

图 3 切换工作模式 

4.1.4 保存截图 

1. 点击菜单栏中的“文件”，选择“保存图片”； 

2. 在“保存图片”弹窗中，设定图片保存路径和图片名，点击“确认”保存截图（未外接外部扩展存储

器时，图片默认保存在本地，外接存储器后，可选择直接保存至存储器）。用户也可以通过点击菜单栏中

的快捷按键“ ”进行截图。 

4.1.5 预设 

点击菜单栏中的“预设”按钮，可将当前上位机软件的配置恢复为仪器的默认初始状态。 

4.1.6 单次与连续预览 

单次预览：点击“单次”，连续预览：点击“连续”。 
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4.1.7 快捷记录与回放 

记录：点击菜单栏中的“Rec”，将开始记录数据，点击“stop”停止记录。 

回放：点击菜单栏中的“Play”，回放最近一次的记录数据，点击“Pause”暂停回放。 

点击菜单栏的“Continu.”按钮，可以恢复正常的数据采集和显示。 

 

图 4 快捷记录与回放 

4.1.8 专业和简洁设置 

点击菜单栏中的“系统”→“设置模式”，即可在“简洁设置”和“专业设置”之间进行切换。相比简洁

模式，专业模式在主设置区提供更全面的参数选项，用户可以根据需求灵活选择合适的设置模式。 

4.1.9 主题设置 

点击菜单栏中的“系统”→“主题”，即可在“深色”和“明亮”主题之间切换。 

4.1.10 参数设置 

点击菜单栏中的“系统”→“参数设置”，在弹出的设置窗口中可以进行如下功能设置： 
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表格 4 参数设置参数说明 

参数 说明 

震动反馈 开启后，触屏操作仪器时，仪器通过震动提供触觉反馈 

屏幕锁 开启后，屏幕右侧会出现锁定图标“ ”，点击该图标至“ ”可锁定屏幕，防止

误操作，再次点击可解锁 

数值检波 开启后，可降低包括游标在内的部分参数的显示刷新频率，便于用户观察与记录 

空闲亮度降低 开启后，若用户在一分钟内无任何操作，仪器将自动降低屏幕亮度，以节省能耗 

4.1.11 隐藏面板 

点击菜单栏中的隐藏图标“ ”，隐藏主设置区菜单，增大显示区域。 

4.1.12 查看当前仪器信息 

点击菜单栏中的“系统”→“关于”，当前仪器信息将在“关于”弹窗中显示。 

4.1.13 瀑布图 

仅 SWP 模式、IQS 模式和 RTA 模式支持瀑布图功能。点击瀑布图图表区域对应的“Graph”面板，可

进入瀑布图参数设置界面，各控件的功能说明如下表所示： 

表 5 瀑布图控件介绍 

图表设置区 

Scan Depth 控制瀑布图 y轴上缓存的时间长度 

缓存上限：8000行像素 
Time Density 控制瀑布图刷新速度 

当设置为 100时，每秒滚动 100行像素 
ColorGradation 设置瀑布图色阶 

1. 在频谱图的图表设置区点击“Graph”按钮，选择弹出菜单中的“Spectrogram”可启用瀑布图显

示。 



 

PX 系列用户指南 14 

 

图 5 启用瀑布图 

2．点击瀑布图，切换至对应的图表设置区，然后点击“Graph”→“导出数据”，即可将当前缓存的，

不超过扫描深度的数据导出为 CSV 格式（默认导出路径：“/media/rpdzkj/userdata/Studio/data”），

导出的数据按时间倒序排列。 

4.1.14 图表缩放功能 

图表缩放功能可用于查看频谱图或时域图中局部区域的细节信息，仪器提供两种缩放方式：Zoom 缩放

功能和放大镜放大功能，用户可根据需求灵活选择。 

1. Zoom 缩放 

(1) 频谱放大图（仅 SWP 模式） 

1） 点击“Graph”，在弹出的子菜单中打开“Zoom”; 

2） 点击选中频谱放大图，点击“Graph”，在弹出的子菜单中设置需要放大的频率范围，或直接拖动频

谱图中的放大框及其边缘，以调整位置和放大区域。 
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图 6 SWP 模式下频谱放大 

(2) 时域放大图（仅 IQvT、PvT 和 DET 模式） 

1）  IQvT 和 PvT 

IQS 模式下，点击主设置区“IQvT”或“PvT”，选择相应通道，打开“分析”和“缩放”，通过按住

缩放区域滑动缩放框、按住缩放边框左右拖动的方式调整缩放区域。 

2） DET 模式 

a) 点击“Graph”，在弹出的子菜单中打开“缩放”; 

b) 按住缩放区域滑动缩放框、按住缩放边框左右拖动、选中缩放图“PvT Zoom”，点击“Graph”，设

置“时间中心点”和“时间宽度”。均可调整缩放区域。 

2. 放大镜放大 

(1) 点击放大镜按钮“ ”，框选出感兴趣的区域； 

(2) 主界面右上角将显示一个缩略框视图，展示完整的迹线以及被放大区域在全局中的位置； 

(3) 用户可通过拖动缩略图中的红框来快速切换放大区域的位置，也可重新框选新的区域进行放大； 

(4) 再次点击放大按钮，即可退出放大视图，恢复原始迹线显示。 
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图 7 SWP 模式下放大镜放大 

4.1.15 记录与回放 

记录与回放功能重要参数说明请参见表 6。 

表 6 记录与回放参数说明 

记录  

RecordMode 

固定时长：可预设记录点数、记录时长及文件大小限制（注意：实际记录文件

的大小不得超过硬盘剩余容量） 

手动模式：需手动控制记录文件的记录时长（注意：在手动模式下，当记录文

件大小超过单次文件大小限制时，软件将自动停止记录） 

RecordTime 设置记录时长，仅记录模式为“固定时长”时生效 

FileSizeLimit 单个记录文件的存储大小限制 

Disk 硬盘剩余容量和硬盘总容量 

回放  

Last frame 回退一帧 

Next frame 前进一帧 

Back 回退若干帧 

Forward 前进若干帧 
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1. 数据记录 

(1) 点击主设置区“Record”→“记录模式”，选择记录模式； 

(2) 点 击 “ 文 件 路 径 ”， 设 置 记 录 文 件 的 存 放 路 径 ， 默 认 存 放 路 径 为 ：

“/media/rpdzkj/userdata/Studio/data”，用户可自定义存储位置，若连接了外部存储器，也可选择

将记录文件保存至外部设备中； 

(3) “固定时长”模式下，点击“记录”，自动记录预设大小的数据。“手动”模式下，通过点击“记录”

和“停止”，手动控制记录时长，当记录文件大小超过文件大小限制时，自动停止记录。 

2. 数据的回放 

(1) 点击主设置区“Play Back”→“打开文件”，在弹窗中选择需要回放的记录文件； 

(2) 点击“回放”开始回放、点击“暂停”停止回放、点击“停止”退出回放界面恢复数据获取，开启“自

动循环”将循环回放该记录文件。 

4.1.16 导出数据 

1. 在需要导出数据的图表设置区，点击“Graph”→“导出数据”。其中，“图片”选项可以将当前图表

导出为 PNG 图片文件，“数据”则将图表数据导出为 CSV 文件； 

2. 在“保存数据”弹窗中，设定数据保存路径和数据名，点击“确认”保存图片/CSV 文件（未外接外

部扩展存储器时，默认保存在本地，外接存储器后，可选择直接保存至存储器）； 

3. PX 系列仪器默认将数据存储在：/media/rpdzkj/userdata/Studio 文件夹下的子文件夹中，包括

images（图表图片）、data（记录文件和配置文件）、reports（图表数据 CSV 文件和相应的配置文件）； 

4.1.17 删除文件与图像 

1. 点击“File”→“Exit”退出上位机软件运行界面； 

2. 进入“/media/rpdzkj/userdata/Studio/images”，将图片拖放至“Trash Can”，并在 Confirm

弹窗中点击“Yes”，即可删除截图（记录文件和配置文件删除与截图删除方式一致）。 
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图 8 删除图像 

4.1.18 采样率修改 

IQS 模式下，点击主设置区“BW”，修改子菜单中“IQSampleRate”的值可以修改仪器的采样率。 

 

图 9 修改原生采样率 

4.1.19 快捷参数设置 

快捷参数设置目前支持：参考电平、RBW、VBW、检波器、起始频率、终止频率、扫宽、中心频率等频

谱分析常用参数进行快速设置。 
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图 10 设置快捷参数 

4.1.20 显示偏移 

1. 点击图表设置区“Graph”→“显示偏移”，在偏移量设置界面中输入偏移值，其中正值表示将迹线

向下偏移，负值表示将迹线向上偏移； 

2. 用户也可点击图表设置区“ ”图标，启用后可直接在显示屏上通过手指上下滑动来拖动迹线位置，

实现快速调整。 

4.2 幅度修正 

为确保频谱测量的准确性与可重复性，仪器提供幅度修正功能，支持用户通过手动输入外部增益/损耗、

导入频率响应修正表的方式进行补偿。 

4.2.1 补偿规则 

▪ 当前扫宽内起始频率到第一个补偿点之间，按照第一个频点的偏移值进行补偿； 

▪ 多个补偿点之间，根据修正表中的频点数据，采用线性插值进行补偿； 

▪ 最后一个补偿点到终止频率之间，按照最后一个频点的修正值进行补偿。 
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4.2.2 幅度修正示例 

以 1 GHz-3 GHz 频段补偿-20 dB，3 GHz-5 GHz 频段进行-20 dB-10 dB 插值补偿，5 GHz-7 GHz 频

段补偿 10 dB 为例，操作步骤如下： 

1. 点击“Frequency”，将“起始频率”设置为“1 GHz”，“终止频率”设置为“7 GHz”； 

2. 点击菜单栏“系统”→“幅度修正”； 

3. 在弹窗中启用幅度修正功能，接着点击“添加”，每次可添加一个频点修正项； 

4. 将频率 1 设置为“3 GHz”，偏移 1 设置为“-20 dB”，再次点击添加，并将频率 2 设置为“5 GHz”，

偏移 2 设置为“10 dB”； 

5. 点击弹窗右下角“Apply”，应用幅度修正功能。 

 

图 11 幅度修正应用 

6. 用户可通过弹窗中“Export”，将当前修正配置导出为 Excel 表格文件（默认导出路径：

“/media/rpdzkj/userdata/Studio/data”）； 

7. 用户也可按照导出配置的格式，自定义幅度修正表，并通过“Import”按钮导入。 
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4.3 Graph功能 

图表设置区 Graph 子菜单参数说明详见下表： 

表格 7 图表功能参数说明 

图表  

刻度/格 调整显示界面每个网格线的间隔。范围：1 dB – 100 dB 

显示偏移 参见 显示偏移 章节 

刻度复位 将图表的显示状态恢复至默认配置 

单位 dBm、dBmV、dBmA、W、V、A、dBuV、dBuA、dBpW 

瀑布图 参见 瀑布图 章节 

缩放图 参见 图表缩放功能 章节 

创建游标对 参见 游标功能 章节 

导出数据 参见 导出数据 章节 

4.4 游标功能 

游标功能主要在图表设置区的“Marker”子菜单中设置，此外，上位机软件还提供了一些游标的快捷使

用方法，本节将详细说明游标的使用方式。 

4.4.1 创建游标 

1. 创建单个游标 

双击图表显示区，或点击图表设置区的“Peak Search”按钮，可快速唤出参考游标。 

2. 创建多个游标 

点击图表设置区的“Marker”子菜单，选择需要创建的游标，然后点击“启用”，启用所选游标。 

4.4.2 创建游标对 

点击图表设置区“Graph”，在弹窗中选择“创建游标对”，快速启用一对参考游标和差值游标， 

连续点击，启用多对游标（当前上限 5 组）。 
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4.4.3 关闭游标 

1. 关闭单个游标 

点击图表设置区的“Marker”子菜单，选择需关闭的游标，然后点击“启用”即可关闭所选游标。 

2. 关闭所有游标 

点击图表设置区“Graph”，在弹窗中选择“关闭所有游标”。 

4.4.4 修改游标频率 

在配备触摸屏的仪器中，用户可通过多种方式灵活地修改游标的频率位置，以便更精准地观察和分析信

号特征。以下介绍两种常用的操作方法: 

1. 手动输入频率值 

点击“Marker”子菜单，选择已启用的游标(如 M1R、M2R)，点击弹窗上方“频率:”区域，设置游标频

率值。 

2. 拖动游标或点击跳转 

(1) 拖动游标：按住游标并拖动至期望位置后松开； 

(2) 点击跳转：选中游标后双击目标频点，游标自动跳转至该位置。 

4.4.5 游标寻峰 

1. 局部寻峰 

在局部峰值附近双击图表，或者选中游标后点击“Marker”→“局部寻峰”。 

2. 全局寻峰 

点击图表设置区中的“Peak Search”，即可开启全局寻峰。 

4.4.6 差值游标 

差值游标要与参考游标一起使用，表示与参考游标之间的频率差、时间差和幅度差。 
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图 12 启用差值游标 

4.4.7 噪声密度 

创建游标之后，在图表设置区的“Marker”中打开“噪声密度”，可以将原先的功率值转换为每赫兹的功

率密度。 

4.4.8 游标至中心 

将参考游标移动到目标频率位置后，点击图表设置区“Marker”中的“游标至中心”，将游标所在的频

率对齐到中心位置。 

4.4.9 游标至模式 

将参考游标移动到目标频率位置后，点击图表设置区“Marker”选项中的“Switch To”按钮，即可快

速切换其他工作模式，并将当前游标位置的频率值设为新模式的中心频率。 
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图 13 游标至模式 
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5. GNSS 使用说明 

本章将详细说明如何使用仪器内置或外接的用户自定义 GNSS 模块，获取实时定位数据，以及如何使用

内置 GNSS 模块的 1PPS 触发。 

5.1 使用外部 GNSS模块 

仪器支持通过 USB 转串口方式接入用户自定义的外部 GNSS 模块。用户可将模块的串口输出通过 USB

转串口线连接至仪器的 USB 接口，系统将其识别为虚拟串口并解析收到的 GNSS 数据。操作步骤如下： 

1． 使用 USB 转串口线将外部 GNSS 模块连接至仪器的 USB 口； 

2． 在软件中点击“系统”，选择下拉菜单中的“GNSS 信息”； 

3． 在弹窗中，将“GPS 类型”设置为“外置 GPS”； 

4． 点击“COM 设备”栏的“刷新”按钮，选择新识别到的“ttyUSBX”设备； 

5． 设置“比特率”为 GNSS 模块的实际输出（如“9600”），并点击下方的“连接”按钮； 

6． 仪器将解析并显示收到的 GNSS 定位信息，GNSS 信息弹窗中参数解释参见下表。 

 

图 14 连接外部 GNSS 模块 
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表格 8 GNSS 参数说明 

序号 参数 说明 

1 GPS Type 选择内部/外部 GNSS 模块 

2 Baud Rate 外部 GPS 模块的串口波特率 

仅使用外部 GNSS 模块时需要设置 
3 Format 提供“本地时间”和“UTC 时间”两种时间格式 

4 Antenna 选择“内部天线”或“外部天线”（目前仅支持外部天线） 

仅使用内部 GNSS 模块时需设置 
5 SatNum 已定位的卫星数量 

6 SNR(Max) 已定位卫星的最大信噪比 

7 SNR(Min) 已定位卫星的最小信噪比 

8 SNR(Avg) 已定位卫星的平均信噪比 

5.2 使用内部 GNSS模块 

5.2.1 连接 GNSS天线 

连接天线和 MMCX 转 SMA 连接线，并将 MMCX 端连接至仪器的 GA 接口（使用外部 GNSS 天线时，

请将天线的接收面朝向无遮挡的天空）。 

 

图 15 连接 GNSS 外部天线 

5.2.2 锁定内部 GNSS 

1. 点击“系统”→“GNSS 信息”，在 GNSS 信息框中将“GPS 类型”设置为“内置 GPS”、“天线”

设置为“外部”； 

2. 等待 1-3 分钟后 GNSS 即可锁定，可以根据状态栏信息中 GNSS 锁定标识判断 GNSS 锁定与否，
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锁定后 GNSS 锁定标志标为绿色，若为灰色则未锁定。 

 

图 16 锁定 GNSS 外部天线 

5.2.3 使用内部 GNSS模块的 1PPS触发 

仅 IQS 模式、DET 模式和 RTA 模式下可使用 GNSS 模块的 1PPS 触发。本节将以 IQS 模式为例，详细

说明如何配置 GNSS 模块的 1PPS 触发功能。 

1、 请参考连接 GNSS 天线章节正确连接仪器与天线； 

2、 请参考锁定内部 GNSS 章节确保 GNSS 已锁定； 

3、 点击“模式”→“接收机/IQ 流”，切换至 IQS 模式； 

4、 点击主设置区中“Next”→“Trigger”，在“Trigger”子菜单中将“TriggerSource”设置为 GNSS-

1PPS，以使用 GNSS 模块的 1PPS 触发。 
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图 17 使用 GNSS 1 PPS 触发 

5.2.4 内部 GNSS使用注意事项 

GNSS 模块未锁定时，不建议使用 GNSS 的 1PPS 触发。 
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6. SWP 模式的使用 

本章节着重介绍 SWP 模式的部分重要参数和测试方法。 

6.1 SWP模式通用参数介绍 

SWP 模式部分重要参数说明如表 9 所示。 

表 9 SWP 模式参数说明 

Frequency  

本振优化 

自动：默认低杂散模式 

扫描速度：高扫速模式 

杂散：低杂散模式 

相位噪声：低相噪模式 

Amplitude  

预放 

设置前置放大器动作： 

自动使能：当参考电平低于-30 dBm 左右时，前置放大器开启 

强制关闭：任何参考电平下总保持放大器关闭 

增益策略 
低噪声：侧重低噪声并保持噪底平整 

高线性度：侧重高线性度并保持噪底平整 

中频增益档位 

0-X 档 每档差 3 dB 增益 

提高中频增益挡位：射频增益减小，底噪升高，线性度提升，杂散减少 

降低中频增益挡位：射频增益增加，底噪变低，线性度变差，杂散增多 

衰减 

0-33 dB（不同频段的衰减上限不同），步进为 1 dB 

Atten = -1 dB（默认）：不开衰减 

Atten ≥ 0dB 时：开启衰减，此时参考电平=衰减值-10 

Sweep  

扫描时间模式 

minSWT：以最短扫描时间进行扫描 

minSWTx2：以近似 2 倍最短扫描时间进行扫描 

minSWTx4：以近似 4 倍最短扫描时间进行扫描 

minSWTx10：以近似 10 倍最短扫描时间进行扫描 

minSWTx20：以近似 20 倍最短扫描时间进行扫描 

minSWTx50：以近似 50 倍最短扫描时间进行扫描 

minSWTxN：以近似 N 倍最短扫描时间扫描，N 等于扫描时间倍数 

手动：以近似指定的扫描时间进行扫描，扫描时间等于 SweepTime。 

迹线点数策略 
扫描速度优先：优先保证扫描速度最快，尽量靠近设置的目标迹线点数 

点数准确优先：优先保证接近设置的目标迹线点数 

杂散抑制 无杂散优化、标准杂散优化、增强杂散优化。 
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FFT 执行 

自动：根据设置自动选择使用 CPU 还是 FPGA 进行 FFT 计算（RBW

在 40kHz 以下为 CPU 计算，以上为 FPGA 计算）、CPU 优先、FPGA

优先、CPU 计算-低资源占用、CPU 计算-中资源占用、CPU 计算-高资

源占用、FPGA 计算 

窗型 

FlatTop 窗：更高的幅度准确度 

B-Nuttal 窗：更高的频率选择性 

LowSideLobe 窗：更高的低频信号的测量准确性 

6.2 信道功率 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

6.2.1 参数说明 

此处仅对部分重要参数进行说明：信道功率测量部分重要参数如表 10 所示。 

表 10 信道功率测量参数说明 

信道功率  

积分带宽 设置待测信道的带宽，信道功率为该带宽内的积分功率 

扫宽功率 将测量带宽设置为当前扫宽（Span），计算该范围内的信道功率 

6.2.2 操作步骤 

1. 将中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的

“ChannelPower”； 

2. 软件将自动配置默认参数，测试结果如下图所示。测量方框左上角为信道功率值。在下侧“Channel 

Power”栏中也可查看测量带宽、信道功率、功率谱密度值； 

3. 您可自行调整：信道中心频率（按住测量区域滑动选择）、测量带宽（按住测量边框左右拖动或调整

Meas BW 设置），也可修改主设置区的“中心频率”、“扫宽”、“参考电平”、“RBW”等参数以适配不同

信号的测量。 
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图 18 信道功率测量 

6.3 占用带宽 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

6.3.1 参数说明 

此处仅对部分重要参数进行说明：占用带宽测量部分重要参数如表 11 所示。 

表 11 占用带宽测量参数说明 

占用带宽 

测量方法 XdB、百分比 

XdB/% 设置具体的 XdB值/百分比 

6.3.2 操作步骤 

1. 将中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“OBW”； 

2. 点击“BW”，将“RBW”设置为 50 kHz； 

3. 软件将自动配置测量参数，测量结果如图所示。在下侧“OBW”栏中可查看占用带宽值。 

4. 也可修改主设置区的“中心频率”、“扫宽”、“参考电平”、“RBW”等参数以适配不同信号的测量。 
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图 19 占用带宽测量 

6.4 邻道功率比 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

6.4.1 参数说明 

此处仅对部分重要参数进行说明：邻道功率比测量部分重要参数如表 12 所示。 

表 12 邻道功率比测量参数说明 

邻道功率 

邻道间隔 设置主信道与邻道的频率间隔 

邻道对数 设置邻道对的数量，上限 2 对 

6.4.2 操作步骤 

1. 将中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“ACPR”； 

2. 软件将自动配置默认参数，测试结果如下图所示。其中绿色信道带宽顶部为各信道功率值。下侧

“ACPR”栏中也可查看邻道中心频率、邻道功率和邻道功率比。 

3. 您可自行设置主信道的中心频率、各信道带宽、邻道间隔和邻道对数，也可修改主设置区的“中心

频率”、“扫宽”、“参考电平”、“RBW”等参数以适配不同信号的测量。 
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图 20 邻道功率比测量 

6.5 IP3/IM3 

以测试 1 GHz 频点的 IP3/IM3 为例。 

6.5.1 参数说明 

此处仅对部分重要参数进行说明：IP3/IM3 测量部分重要参数如表 133 所示。 

表 13 IP3/IM3 测量参数说明 

IP3/IM3 

低音频率、功率 输入信号低频部分的频率、功率 

高音频率、功率 输入信号高频部分的频率、功率 

低侧交调频率、功率 交调产生的低侧信号的频率、功率 

高侧交调频率、功率 交调产生的高侧信号的频率、功率 

高低音功率差 输入信号的高低频功率差 

6.5.2 操作步骤 

1. 通过两台信号源和合路器，将中心频率为 999 MHz，幅度为 0 dBm 和中心频率为 1.001 GHz，幅

度为 0 dBm 信号合并成一路信号，输入仪器； 

2. 将仪器中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“IM3”； 
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3. 调整信号功率，使三阶互调干扰信号频谱图中显示为高于底噪 10 dB； 

4. 软件将自动配置默认参数，测试结果如下图所示。下方“IM3”栏中可查看 IP3 测试结果。 

 

图 21 IP3/IM3 测量 

6.6 SEM 

频谱发射模板（SEM）是用于评估无线信号在工作频段之外是否存在过度发射或杂散信号的测量功能。 

以评估频率为 1 GHz，功率为-20 dBm 的 IEEE 802.11ac 信号是否符合标准为例。 

6.6.1 参数说明 

此处仅对部分重要参数进行说明：SEM 测量部分重要参数如表 134 所示。 

表格 14 SEM 测量参数说明 

SEM 

自动参数设置 与峰值参考类型联动，启用后自动以信号峰值作为当前的相对参考值 

参考类型 
手动：启用后，用户可自定义相对参考电平 

峰值：启用后，将当前信号的峰值作为相对参考电平 

手动参考 
设置相对参考电平值。此功能仅在参考类型选择为“手动”时生效 

所设置的手动参考值将作为计算偏移表中起始/终止门限的基准 

偏移表 
开始/截止频率 

设置上偏移频段，表示相对于中心频率的偏移距离。系统

自动生成与中心频率对称的上下偏移频段，最多可配置 16

个偏移频段 

起始/截止门限 设置信号在对应上下偏移频段内的功率限制 
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模式 

绝对：以绝对幅度进行测量，以实际的功率值为基准，与

参考值无关 

相对：相对于设定的“手动参考”值进行测量，基于参考

值计算偏移频段内的功率限制 

优先级 
要求：必须满足模板要求，不满足则视为不合格 

建议：推荐符合模板要求，若未满足则提示警告 

保存表格 
保存当前的测量模板 

默认路径：“/media/rpdzkj/userdata/Studio/data” 

载入表格 载入用户预存的测量模板 

加载模板 

从设备提供的预定义模板中选择合适的模板 

模板类型：802.11a/g、802.11b、802.11n（20MHz、

40MHz）、802.11ac（20MHz、40MHz、80MHz、

160MHz）AM NRSC、FM FCC 73.317、FM NRSC 

Hybrid、AM NRSC 5K Hybrid、AM NRSC 8K 

Hybrid、Bluetooth 

导出测量结果 
以表格的形式将迹线下方的测量表导出 

默认路径：“/media/rpdzkj/userdata/studio/reports” 

6.6.2 操作步骤 

1、 将“中心频率”设置为 1 GHz，“参考电平”设置为-20 dBm； 

2、 点击“Meas”，选择附加菜单中的“SEM”； 

3、 点击“偏移表”，选择弹窗中“加载模板”按钮，在模板列表中选择“802.11ac（20MHz）”模板”； 

4、 点击“BW”，将“RBW”调整为“5 kHz”，“VBW 模式”调整为“VBW = 0.01 RBW”； 

5、 点击“Sweep”，将附加菜单中“扫描时间模式”设置为“minSWT×20”，并将“Detect”设置为

“平均检波”； 

6、 测量结果如下图所示，频谱图中会显示此频谱是否符合模板要求，下方的测量结果表中显示了每个

偏移频段上的最大裕度。 
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图 22 SEM 测量 

6.7 频率追踪 

1. 点击图表设置区“Marker”，在弹出的子菜单中，点击“More”，再点击“Advanced”,设置追踪

信号的峰值门限以及抖动范围（峰值频率在此范围内抖动的时候，不频繁将此时的频率值对齐到中心位

置）； 

 

图 23 设置峰值门限和抖动范围 
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2. 点击“Signal Track”，参考游标在此时的扫宽内进行寻峰，并将此时的峰值信号对齐到中心频率位

置，当目标信号的频率发生漂移时，频谱仪会自动调整自身的中心频率，使信号始终位于图表显示区的中

心区域，方便用户观察和分析。 

 

图 24 频率追踪 

注：一般情况下该功能，只移动频率位置，不改变扫宽。但对于漂移幅度特别大，超出当前扫宽的信号，

难以继续跟踪；对于处在仪器扫描范围边缘的信号，因为频率限制，会进一步减小扫宽。 

6.8 峰值表 

1. 点击图表设置区“Marker”，在弹出的子菜单中点击“More”，再点击“Advanced”，设置峰值表

的门限值，详细设置说明请见频率追踪章节； 

2. 点击“Peak Table”，仪器将自动在当前扫宽范围内检测并标注超过门限的峰值点（上限 10 个），并

在显示区下方的峰值表内，按峰值信号功率从大到小的顺序显示每个峰值的频率和功率信息，方便用户

快速查看频谱内的主要信号。 
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图 25 峰值表 
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7. IQS 模式的使用 

本章详细介绍了 IQS 模式的部分重要参数，着重描述了如何对系统获取的时域 IQ 数据展开进一步的分

析，如频谱分析、时域分析、功率时间分析、数字下变频、解调等。 

7.1 IQS通用参数介绍 

表 15 IQS 模式参数说明 

Frequency 

本振优化 请参见 SWP通用参数介绍同名参数 

BW 

原生采样率 ADC 采样率，可设置 110 MSa/s~130 MSa/s 

分析带宽 显示抽取后的等效采样率：（ADC 采样率/抽取倍数）*0.8 

数据格式 

8bit：精度较低，无信号时容易获取到很多 0，支持 2 抽取及以上连续流

获取 

16bit：默认配置，支持 4 抽取及以上的连续流获取 

32bit：精度较高，支持 8 抽取及以上的连续流获取 

Amplitude 

预放 

请参见 SWP 通用参数介绍同名参数 
增益策略 

中频增益档位 

衰减 

Record 

RecordMode 

请参见记录与回放同名参数 
RecordTime 

FileSizeLimit 

Disk 

Playback 

Last frame 

请参见记录与回放同名参数 
Next frame 

Back 

Forward 
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7.2 IQS模式功能简介 

IQS 模式的初始界面由最大功率时间缩略图、频谱图和时域图组成。点击主设置区的“Next”，再点击

“Trigger”，修改子菜单中“PreviewTime”参数，可调整最大时间缩略图中 IQ 流的预览时间范围。 

频谱图和 IQ 时域图的显示范围分别由最大功率时间缩略图中的红色缩选框“Spectrum-P”和“IQvT-

P”决定。调整缩选框的位置和范围，可观察不同时间段的 IQ 时域信号，也可对不同时间段采集的 IQ 时

域信号进行频谱分析。 

7.3 频谱分析 

7.3.1参数说明 

此处仅对部分重要参数进行说明：频谱分析部分重要参数如表 16 所示。 

表 16 频谱分析部分参数说明 

频谱分析子菜单 

窗型 参见 SWP模式通用参数介绍同名参数 

频谱截取 
频谱截取：如 Intercept = 0.8，显示 80%的 FFT 频谱分析结果，以便将过

渡带频谱成分截取 

7.3.2 操作步骤 

1. 点击主设置区“FFT”，开启“Analyze”，拖动最大功率时间缩略图中的“Spectrum-P”红色缩选

框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段采集的 IQ 信号进行频谱分析，

调整“Frequency”子菜单中“Center”、“BW”子菜单中“Span”的值，可以改变频谱的中心频率和

分析带宽； 

2. 通过“FFTsize”，设置频谱分析的点数、“Window”设置不同的窗函数、“TraceDetector”设置

不同的迹线检波器、“Intercept”对频谱进行截取显示，当 Intercept =0.8 时，可以对过渡带进行截取。 
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图 26 IQ 数据频谱分析 

7.4 IQvT 

7.4.1 操作步骤 

点击主设置区“IQvT”，开启“Analyze”，拖动最大功率时间缩略图中的“IQvT-P”红色缩选框，或调

整“TimeStart”和“TimeLength”的值，可以对不同时间段的 IQ 信号进行时域分析。 

 

图 27 IQ 数据时域图及其放大图 
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7.5 PvT 

7.5.1操作步骤 

点击主设置区“PvT”，开启“Analyze”，拖动最大功率时间缩略图中的“PvT-P”红色缩选框，或调整

“TimeStart”和“TimeLength”的值，可以对不同时间段 IQ 信号进行功率时间分析； 

 

图 28 IQ 数据功率-时间图及其放大图 

7.6 AM解调 

以解调载波频率 1 GHz、功率-20 dBm、调制率 3 kHz、调制深度 70%的 AM 信号为例。 

7.6.1 参数说明 

此处仅对部分重要参数进行说明：AM 解调部分重要参数如表 17 所示。 

表 17 AM 解调参数说明 

滤波子菜单 

n 滤波器抽头数，抽头数越大滤波器过渡带越陡峭，通带波纹越小 

Fc 截止频率，0<Fc<0.5，例如为 0.25 时，则对一半的带宽进行低通滤波 

As 阻带衰减，阻带衰减越大，对阻带的抑制效果越强，按 dB 进行衰减 

mu 分数采样偏移，推荐使用默认值即可 

7.6.2 操作步骤 

1. 设置“Center”为 1.0001 GHz，调整最大功率时间缩略图中“IQvT-P”的范围，选中 IQ 时域图，
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点击“Graph”，选择 Graph 子菜单中的“Auto Range”； 

2. 点击主设置区“Demod”，将下级菜单中“Type”设置为 AM，选中 AM 解调时域图，点击“Graph”

控件下的“Auto Range”； 

3. 点击主设置区“BW”，增大下级菜单中的“Span”以调整分析带宽，本例将分析带宽设置为 12.288 

MHz。 

 

图 29 AM 解调 

7.6.3 音频分析 

可用于测试仪器的解调灵敏度。 

1. 参考 AM 解调章节 解调 AM 信号； 

2. 点击主设置区“Demod”，打开下级菜单中的“AudioAnalysis”，启用音频分析，查看音频分析的

频率是否与调制率相同，也可以测试信号的信纳德和总谐波失真。 
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图 30 AM 解调音频分析 

7.7 FM解调 

以解调载波频率 1 GHz、功率-20 dBm、调制频率 5 kHz 和频率偏移 75 kHz 的 FM 信号为例。 

7.7.1 参数说明 

请参考 AM 解调参数说明章节。收听 FM 广播信号时，可对 FM 解调后的信号进行低通滤波，减少部分

高频噪声，使收听的声音更纯净。 

7.7.2 操作步骤 

1. 设置“Center”为 1 GHz，调整最大功率时间缩略图中“IQvT-P”的范围，选中 IQ 时域图，点击

“Graph”，选择 Graph 子菜单中的“Auto Range”； 

2. 点击主设置区“Demod”，将下级菜单中“Type”设置为 FM，选中 FM 解调时域图，点击“Graph”

控件下的“Auto Range”； 

3. 点击主设置区“BW”，增大下级菜单中的“Span”以调整分析带宽，本例将分析带宽设置为 6.144 

MHz。 
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图 31 FM 解调 

7.7.3 音频分析 

解调 FM 信号后，请参考音频分析章节对解调后的信号进行音频分析。 

7.8 DDC数字下变频 

对 IQ 数据流进行数字下变频与重采样生成子 IQ 流，进行进一步的频谱分析。下面以频率 1 GHz、功率

-20 dBm 单音信号的 DDC 为例。 

7.8.1 参数说明 

此处仅对部分重要参数进行说明：DDC 数字下变频部分重要参数如表 18 所示。 

表 18 DDC 数字下变频参数说明 

采样子菜单 

OffsetFreq 复混频的频率偏移，>0 时，频谱向右搬移；<0 时，频谱向左搬移 

Decimate 设置 DDC 的抽取倍数，即重采样率 

7.8.2 操作步骤 

1. 设置“中心频率”为 1 GHz，“参考电平”为 0 dBm，调整最大功率时间缩略图中“IQvT-P”的范

围，选中 IQ 时域图，点击“Graph”，选择 Graph 子菜单中的“自动量程”； 
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2. 点击主设置区“DDC”，在附加子菜单中点击“状态 on”打开 Channel1，并设置 DDC1 通道的“中

心频率”为 1.003 GHz，“频率偏移”为-3 MHz，“频率步进”为 1 MHz，“抽取倍数”为 3； 

3. 点击主设置区“FFT”，在附加子菜单中选择“DDC1”，打开“分析”，拖动最大功率时间缩略图中

的“Spectrum-D1”红色缩选框，或调整“起始时间”和“时间长度”的值，可以对不同时间段 DDC 生

成的 IQ 子流进行频谱分析； 

4. 点击主设置区“IQvT”，在下拉菜单中选择“DDC1”，打开“Analyze”，拖动最大功率时间缩略图

中的“IQvT-D1”红色缩选框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段 DDC

生成的 IQ 子流进行时域分析； 

 

图 32 查看 DDC 下 IQ 子流的时域图 

5. 点击主设置区“PvT”，在下拉菜单中选择“DDC1”，打开“Analyze”，拖动最大功率时间缩略图中

的“PvT-D1”红色缩选框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段 DDC 生

成的 IQ 子流进行功率-时间分析。 
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图 33 查看 DDC 下 IQ 子流的功率-时间图 

  



 

PX 系列用户指南 48 

8. DET 模式的使用 

本章详细介绍 DET 模式的部分参数以及该模式下脉冲信号的测量。 

8.1 DET通用参数介绍 

此处仅对部分重要参数进行说明：DET 模式部分重要参数如表 19 所示。 

表 19 DET 模式参数说明 

Frequency 

本振优化 请参见 SWP通用参数介绍同名参数 

Amplitude  

预放 

请参见 SWP通用参数介绍同名参数 
增益策略 

中频增益挡位 

衰减 

8.2 脉冲信号测量 

以测试载波频率 1 GHz、功率-10 dBm、脉冲周期为 80 us 和脉宽为 40 us 的脉冲调制信号为例。 

8.2.1 操作步骤 

1. 将“中心频率”设置为 1 GHz，点击菜单栏“单次”，开启单次预览模式； 

2. 点击图表设置区的 Graph，点击“缩放”，打开缩放，调整缩放区域（按住选中缩放区域滑动缩放框、

按住缩放边框左右拖动）； 

3. 选中缩放图，点击图表设置区的“Graph”，选择“创建游标对”创建两组游标对，将 M1R 游标移

至脉冲上升沿处，M1D 移至同一脉冲下降沿处，M2R 移至脉冲上升沿处，M2D 移植至下一脉冲上升沿

处。此时在缩放图左上角 M1D 游标和 M2D 游标的显示结果分别为脉冲信号的脉宽、脉冲周期，可根据

以下公式计算出占空比。 

占空比 =
脉宽

脉冲周期
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图 34 脉冲信号周期和脉宽测量 

8.3 脉冲信号检测（选件） 

本章介绍脉冲信号检测的基本操作方法，以及后期补购脉冲检测选件的客户如何获取和放置许可证。 

8.3.1 申请许可证 

如果您购买设备时已包含脉冲检测选件，可忽略本章节内容。若您后期补购脉冲检测选件，请按照以下步

骤获取并放置脉冲检测许可证，以便正常使用该功能。 

1. 参考查看当前仪器信息章节，查看软固件版本； 

2. 确保版本达到以下要求； 

▪ GUI 版本：4.3.55.6 或以上 

▪ API 版本：0.55.55 或以上 

▪ FPGA 版本：0.55.15 或以上 

▪ MCU 版本：0.55.32 或以上 

3. 若软固件版本未达到上述要求，请联系官方技术支持更新软固件至所需版本，并申请相应设备的脉

冲检测许可证。 
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4. 点击“File”→“Exit”退出上位机软件运行界面； 

5. 将技术支持提供的“PX_Demod”文件拷贝至 U 盘，并将 U 盘插入仪器上面板的 USB 端口，在弹

出的“Removable medium is inserted”提示框中点击“OK”； 

6. 将 U 盘中的“PX_Demod”文件夹通过拖放的方式复制至桌面； 

7. 进入“PX_Demod”文件夹，单击“Tools”启动终端。输入 sudo sh install.sh 并按 Enter，根据

提示输入密码 rpdzkj 后再次按 Enter。终端提示“The option has been successfully installed”即表

示安装成功。 

 

图 35 安装脉冲检测选件许可证 

8. 关闭弹窗并启动上位机软件，点击菜单栏“Mode”→“Power Detection”进入检波分析模式，启

用主设置区“Pulse Det”，即可正常使用脉冲信号检测功能。 
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图 36 启用脉冲信号检测功能 

8.3.2 参数说明 

此处仅对部分重要参数进行说明：脉冲信号检测部分重要参数如表 20 所示。 

表格 20 脉冲信号检测参数说明 

Pulse Det 

阈值 脉冲检测门限，大于该门限值的脉冲信号才会被判定为有效脉冲 

最大脉冲数量 当前预览时间下脉冲信号检测上限 

8.3.3 操作步骤 

以 1 GHz，-20 dBm，脉宽 40 us，脉冲周期 80 us 的脉冲信号的检测为例。 

1. 将“中心频率”设置为 1 GHz，“参考电平”设置为 0 dBm； 

2. 点击主设置区“BW”，调整附加菜单中“BW”的值设置不同的分析带宽，本例中将“分析带宽”设

置为 61.44 MHz； 

3. 点击主设置区“Trigger”，将“预览时间”设置为 500us； 

4. 点击主设置区“Pulse Det”，启用脉冲检测功能。拖动功率时间图中的“Trigger.Level”的值，设

置脉冲检测阈值，调整“Pulse Count”的值，设置当前预览时间下脉冲信号检测上限； 

5. 点击菜单栏“Single”，当前配置下的脉冲检测结果如下图所示。从图中可以得到每个检测到脉冲信
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号的峰值电平（dBm）、基准电平（dBm）、上升时间、上升沿、下降时间、下降沿、脉宽、周期和占空

比等参数。以及所检测到脉冲信号的统计参数，如：最大、最小、平均脉冲周期和脉宽、周期偏差百分比

和脉宽偏差百分比。 

 

图 37 脉冲检测结果 
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9. RTA 模式的使用 

本章详细介绍了 RTA 模式的部分参数、概率密度图的关闭以及该模式下 WIFI 信号的测量。 

9.1 RTA通用参数介绍 

此处仅对部分重要参数进行说明：RTA 模式部分重要参数如表 21 所示。 

表 21 RTA 模式参数说明 

Frequency 

本振优化 请参见 SWP 通用参数介绍同名参数 

Amplitude 

预放 

请参见 SWP通用参数介绍同名参数 
增益策略 

中频增益档位 

衰减 

Sweep 

扫描时间模式 

请参见 SWP通用参数介绍同名参数 

窗型 

9.2 概率密度图 

9.2.1 参数说明 

Graph 

概率图 On：启用概率密度图显示 

Off：关闭概率密度图显示 

色阶 天空色、深海色（默认）、喷射色、冷度色、热度色、灰度色 

余晖 增大：延长信号残影显示时间，适合捕捉突发信号 

减小：加快刷新速度，适合追踪持续信号 

9.2.2 关闭概率密度图 

点击图表设置区“Graph”，在弹窗中关闭“BitMap”，即可关闭概率密度图。 
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图 38 关闭概率密度图 

9.3 WIFI信号测量 

1. 将天线连接至射频输入端口“RFIN”； 

2. 将“Center”设置为 2.44 GHz，增大图表设置区“Graph”子菜单下的“Afterglow”余晖值，即

可更明显的观测 WIFI 信号。 

 

图 39 WIFI 信号的概率密度图 
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10. 数字解调（选件） 

本章介绍数字解调的基本操作方法，以及客户如何通过安装许可证启用该功能。 

10.1 申请许可证与数字解调库 

如果您购买设备时已包含数字解调选件，可跳过本章节内容。若您后期补购数字解调选件，请按照以下步

骤获取并放置数字解调许可证及相关解调库，以确保功能正常使用。 

1. 参考脉冲信号检测申请许可证章节，申请当前设备对应的 PX_Demod 文件夹，并通过 sudo sh 

install.sh 命令一键安装相应的许可证和解调库； 

2. 关闭弹窗并启动上位机软件，点击菜单栏“模式”→“数字解调”，即可正常使用数字解调功能。 

10.2 参数说明 

此处仅对部分重要参数进行说明：部分重要参数如表 17 所示。 

表格 22 数字解调参数说明 

Digital Demod  

符号率 信号每秒传输的符号数量，需按照调制信号的符号率填写，以确保接收

端能够正确解调 

模式 2ASK、2FSK、4FSK、GMSK、BPSK、QPSK、8PSK、16QAM、

64QAM、128QAM、256QAM 

滤波滚降系数 用于限制信号带宽的滤波器在过渡带的滚降速率，需与发射端的滚降系

数保持一致，以确保解调器对信号的有效处理和正确解调 

10.3 功能简介 

数字解调模式的初始界面由调制信号频谱图、解调后的星座图、眼图和解调参数组成，深入分析信号的调

制质量，提供多项误差指标，有效评估信号在传输中的完整性和可靠性。 

10.4 操作步骤 

以解调 1 GHz，-20 dBm，符号率 100 kHz，滤波滚降系数 0.35 的 64QAM 信号为例。 

1. 将“中心频率”设置为 1 GHz，“参考电平”设置为 0 dBm； 
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2. 点击主设置区“Demod”，将附加菜单中“ModType”设置为 QAM64，“SymbolRate”设置为 1 

MSPS，“FilterType”设置为 0.35，点击菜单栏“Single”，当前配置下解调结果如下图所示。星座图中

星座点清晰且分布紧密，理论与实际解调点位置基本重合，说明信号的调制质量高，通信系统的整体性能

较好；眼图清晰且开口较大，说明码间干扰较小，接收端能够可靠地区分符号；与此同时还能得到误差矢

量幅度（EVM）、幅度误差、相位误差、频率误差、信噪比（SNR/MER），以及部分解码后的比特序列。 

 

图 40 64QAM 解调 
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11. 谐波分析模式 

11.1 版本要求 

1. 参考查看当前仪器信息章节，查看软固件版本； 

2. 确保 GUI 版本为 4.3.55.24 或以上，API、FPGA 以及 MCU 版本为 0.55.0 以上即可； 

3. 若 GUI 版本未满足上述要求，请联系官方技术支持获取相应版本的上位机软件。 

11.2 启用谐波分析功能 

软固件更新至所需版本之后，重新启动上位机软件，点击菜单栏“模式”→“谐波分析”，即可正常使用

谐波分析功能。 

11.3 参数说明 

表格 23 谐波分析参数说明 

Frequency  

中心频率 基波的中心频率 
Span  

扫宽 各阶谐波的测量宽度。范围：10 Hz – 100 MHz  
Amplitude  

显示偏移 调整频谱图在幅度轴上的位置 

Meas  

谐波数 设置要测量和绘制的谐波个数，上限 10 个。 

测量类型 
峰值：测量基波和各阶谐波的峰值功率 

信道功率：测量基波和谐波在各自扫宽内的信道功率 

迹线类型 
实时更新：实时更新频谱图，适用于观测信号的瞬时变化 

最大保持：保持显示信号的峰值，适用于捕捉瞬时峰值 

峰值跟踪 On：开启对基波信号的峰值追踪功能，将基波信号峰值对齐至中心频率 

总谐波失真 用于衡量信号的失真程度 

11.4 操作步骤 

以测量 1 GHz，-20 dBm 信号的三次谐波为例。 

1. 点击主设置区“Frequency”，在附加菜单中将“中心频率”设置为 1 GHz； 

2. 点击“Amplitude”，将参考电平设置为-10 dBm。 
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3. 点击“Meas”，将“谐波数”设置为 3，并打开“峰值跟踪”，其他参数保持默认配置； 

4. 点击“Span”，将扫宽设置为 10 MHz； 

5. 点击“BW”，调整 RBW 和 VBW 的值，使迹线趋于平稳。本例中将 RBW 设置为 1 kHz，VBW 设

置为 100 Hz； 

6. 测试结果如下图所示，频谱图右上角显示了总谐波失真率（THD）。下方谐波测量表中，列出了二次

三次谐波的频率、幅度及其与基波之间的差值。 

 

图 41 三次谐波测量 
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12. 相位噪声测量模式 

12.1 版本要求 

1. 参考查看当前仪器信息章节，查看软固件版本； 

2. 确保版本达到以下要求 

▪ GUI 版本：4.3.55.12 或以上 

▪ API 版本：0.55.58 或以上 

▪ FPGA 版本：0.55.17 或以上 

▪ MCU 版本：0.55.49 或以上 

3. 若软固件版本未达到上述要求，请联系官方技术支持将软固件更新至所需版本。 

12.2 启用相位噪声测量功能 

软固件更新至所需版本之后，重新启动上位机软件，点击菜单栏“Mode”→“Phase Noise”即可正常

使用相位噪声测量功能。 

 

图 42 启用相位噪声测量功能 
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12.3 参数说明 

此处仅对部分重要参数进行说明：相位噪声测量部分重要参数如表格 24 所示。 

表格 24 相位噪声测量模式参数说明 

Frequency  

中心频率 设置基波的中心频率 

起始频偏 设置频率偏移的起始点，范围：1 Hz~9 MHz 

终止频偏 设置频率偏移的起始点，范围：10 Hz~10 MHz 

载波识别门限 设置载波识别门限，高于该门限的载波才会被识别 

Meas  

RBW/Offset RBW 比例（各频率分段 RBW/各频率分段的起始频率），范围：

0.01~0.3 

检波设置 
帧检波率：推荐使用默认配置，若待测信号近端存在明显的低频抖动，

可增大近端的帧检波率，获取更稳定的测量结果 

Trace  

平均 设置迹线平均的次数 

平滑 
开启：启用迹线平滑功能 

关闭：关闭迹线平滑功能 

窗长度 设定平滑算法的窗口长度，范围：0~10% 

12.4 操作步骤 

12.4.1 已知载波信息的相位噪声测量 

以测量 1 GHz，0 dBm 信号在 100 Hz 至 10 MHz 偏移范围内的相位噪声为例。 

1. 点击主设置区“Frequency”，在附加菜单中将“中心频率”设置为 1 GHz，“起始频偏”设置为 100 

Hz，“终止频偏”设置为 10 MHz，其余参数推荐使用默认配置； 

2. 若待测信号近端存在较强抖动，可点击主设置区“Meas”，然后在附加菜单中选择“检波设置”，在

弹出的窗中，适当增大对应频段的帧检波率，获得更收敛的测量结果； 
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图 43 脉冲信号检测检波设置 

3. 若单边带相位噪声谱图中存在较明显的杂散，可点击主设置区“Trace”，然后在附加菜单中选择“窗

长度”，逐步增大其参数值，以减小杂散对测量结果的干扰； 

4. 仪器将自动完成设定频偏范围内的相位噪声测量，测量结果如下所示。在界面下方的相噪测量表中，

可以得到载波的信息以及各特征频偏点的相位噪声值（单位：dBc/Hz）。 

 

图 44 相位噪声测量结果 



 

PX 系列用户指南 62 

12.4.2 未知载波信息的相位噪声测量 

当信号载波参数未知时，建议按照以下流程进行相位噪声测量。 

1. 点击“搜索载波”，仪器将自动进行全频段扫描，搜索并定位超过载波门限的峰值信号作为待测载波； 

2. 定位到载波信号后，可参考已知载波信息的相位噪声测量章节，设置起始频偏和终止频偏，进行相

噪测量。 
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13. 其他功能的使用 

本章简要介绍了仪器的中频输出以及触发功能、输入外部参考时钟和对设备进行远程控制。 

13.1 触发功能介绍 

13.1.1 SWP扫频模式 

触发输入 

触发源 扫描模式触发源：自由运行、外部-触发帧、外部-触发扫描、外部-触发配置 

触发边沿 上升沿、下降沿、双边沿 

触发输出 

触发输出 

无触发 

跳频触发：每完成一帧分析输出一个触发 

扫描触发：每完成一次迹线扫描输出一个触发 

配置触发：每切换一次配置输出一个触发 

触发输出脉冲极性 正脉冲、负脉冲 

13.1.2 IQS、DET、RTA定频点模式 

触发输入 

触发源 

定频点模式触发源：外部触发、总线触发、电平触发、定时器触发、多

机同步触发、GNSS-1PPS触发和 GNSS-1PPS多机同步触发 

触发边沿 上升沿、下降沿、双边沿 

触发延迟 设置触发之后，延迟采集的时间 

预触发 设置触发之前，提前采集的时间 

重触发 仪器在捕捉到一次触发后，多次响应 

重触发次数 单次触发响应后，额外需要做几次响应 
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重触发间隔 单次触发仪器多次响应的时间间隔，同为定时器触发模式下的触发周期 

触发输入-电平 

电平门限 设置电平触发门限值，高于门限值表示达到触发条件 

防抖安全时间 设置电平触发防抖安全时间 

触发输入-定时器 

定时周期 定时器触发模式下的触发周期 

同步 不与外触发同步、与外触发上升沿同步、与外触发下降沿同步、 

与外触发上升沿单次同步、与外触发下降沿单次同步、与 GNSS-1PPS

上升沿同步、与 GNSS-1PPS下降沿同步、与 GNSS-1PPS上升沿单

次同步、与 GNSS-1PPS下降沿单次同步 

13.2 中频输出应用指南 

模拟中频输出信号的频率在 307.2 MHz±50 MHz 之间，每台仪器模拟中频输出的中心频率，可以在仪

器的中频校准文件中查看。 

 

图 45 查看中频输出的中心频率 
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13.3 外部参考时钟输入 

参考时钟输入的波形可以选择正弦波、方波或削峰正弦，频率必须设置为 10 MHz，幅值为 3.3V CMOS 

电平。 

下面以 GPSDO 作为 10 MHz 参考时钟输入： 

1. 将 GPSDO“10 MHz”口通过 BNC 转 MMCX 线连接至仪器的“RI”接口。连接图如下所示： 

 

图 46 10 MHz 参考时钟输入 

2. 点击主设置区“Next”-“System”，设置参考时钟频率“RefCLKFreq“为 10 MHz，参考时钟源

“RefCLKSource”选择“External”。如果参考时钟源显示“External”则表示切换成功，如果参考时

钟源回弹为“Internal”且出现错误弹窗则表示切换失败，此时可点击“Preset”，重新切换回内部时钟

使用。 

 

图 47 使用外部 10 MHz 参考时钟 
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13.4 远程控制指南 

13.4.1 网口直连 

1. 将免驱动带网口的扩展坞连接至仪器上面板的 USB 口（其中 USB3 为 USB 3.0 接口，USB1 和 USB2

为 USB 2.0 接口）； 

 

图 48 外接免驱带网口的扩展坞 

2. 将扩展坞通过网线连接至计算机或嵌入式仪器的网口； 

3. 点击菜单栏“文件”→“退出”，退出上位机软件； 

4. 按照上述步骤成功连接后，在 PC 端打开“Settings”，选择“Network & Internet”，点击

“Properties”； 

5. 进入 PC 端以太网配置界面，找到 IP 部分点击“Edit”，选择“Manual”设置 IP，开启 IPv4 选项，

设置 IP地址与子网掩码（计算机的 IP与仪器 IP需在同一网段下）。例如将电脑 IP地址设置为 192.168.1.2，

子网掩码设置为 255.255.255.0； 

 
图 49 配置 IP 地址与子网掩码 
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6. 打开 cmd 窗口，输入“ping 192.168.1.100”，若可以 ping 通，则网络连接成功； 

 

图 50 测试仪器网络连接（ping 命令） 

7. 进入 PC 端上位机软件目录下的 configuration 文件夹，双击打开 Settings.ini 文件，将 Interface

设置为 ETH； 

 

图 51 修改 PC 端软件配置文件 

8. 将仪器“/media/rpdzkj/userdata/Studio/bin/CalFile”目录下的校准文件通过拖放操作，保存

至外接存储设备。 
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图 52 获取仪器校准文件 

9. 将校准拷贝至 PC 端“Studio/bin/CalFile”目录下，然后双击“bin”目录中的可执行程序，打开

软件界面，实现对 PX 系列仪器的远程控制。 

 

图 53 网口直连方式远控 PX 仪器 

注：仪器与 PC 端的软件不能同时开启。 

13.4.2 局域网连接 

1. 将免驱动带网口的拓展坞连接至仪器上面板的 USB 口（其中 USB3 为 USB 3.0 接口，USB1 和 USB2
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为 USB 2.0 接口）； 

2. 将扩展坞通过网线连接至路由器的网口； 

 

图 54 连接路由器与仪器 

3. 点击菜单栏“File”→“Exit”，退出仪器中的软件界面； 

4. 点击“userdata”→“Tools”→“Open Current Folder in Terminal”； 

 

图 55 打开终端 

5. 在终端中输入“ifconfig”查询当前路由器给仪器分配的 IP 地址，本例中 IP 地址为“192.168.31.55”; 
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图 56 查询仪器所获动态 IP 

6. PC 端通过 WIFI 连接到同一个路由器，与频谱仪处于同一个局域网中，打开 PC 端软件文件夹中

configuration 目录下的 Settings.ini 文件，将 Interface 设置为 ETH，将 Address 设置为

“192.168.31.55”； 

 

图 57 修改 PC 端软件配置文件 

7. 将仪器“/media/pdzkj/userdata/Studio/bin/CalFile”文件夹中的校准文件通过拖放的操作，

保存至外接存储设备。 
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图 58 获取仪器校准文件 

8. 将校准拷贝至 PC 端“Studio/bin/CalFile”目录下，然后双击“bin”目录中的可执行程序，打开

软件界面，实现对 PX 系列仪器的远程控制。 

  

图 59 局域网方式远控 PX 仪器 

  



 

PX 系列用户指南 72 

14. 软件更新 

本章介绍了如何使用.deb 包更新仪器上位机软件 

14.1 软件更新规则 

仪器的 MCU 固件、FPGA 固件、软件（API）在同一大版本内才能正常使用，不同大版本之间互不兼容，

例如同为 0.55.x 才可正常使用。 

版本查看方式：参考查看当前仪器信息章节 

14.2 .deb安装包更新上位机软件 

1. 联系官方技术支持获取 PX 系列仪器软件安装包并拷贝至 U 盘； 

2. 正常打开仪器，点击菜单栏“File”→“Exit”，退出上位机软件； 

3. 使用 USB 或 Type-c 接口的 Hub，将携带.deb 安装包的 U 盘以及鼠标键盘连接至仪器； 

 

图 60 外接 U 盘、鼠标和键盘 

4. 将 U 盘中的.deb 安装包拷贝至仪器中； 

5. 点击 Tools，然后点击 Open Current Folder in Terminal 打开终端； 
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图 61 打开终端 

6. 输入 cd ~/Desktop/进入桌面； 

7. 输入 sudo dpkg -i EN_PXConfig_3.55.22.23.deb （注：输入指令时， deb 包的版本

“EN_PXConfig_3.55.22.23.deb”按照实际使用的版本输入）安装.deb 安装包，按 Enter 键确认。接

着根据提示输入密码 rpdzkj，然后再次 Enter，并等待安装； 

 

图 62 上位机软件更新 

8. 等待安装包运行完毕，设备会自动重启并进入新版本的上位机软件界面，此时上位机软件安装完成。 

9. 点击菜单栏中的“System”，选择下拉菜单中“About”，查看弹窗中的 GUI 与 API 是否已更新为

最新版。 

14.3 上位机软件误删处理 

若在平时使用仪器时误删上位机软件导致仪器无法使用，可按照.deb 安装包更新上位机软件流程修复。 
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